**Calculate Median**: Before selecting this option, the marker or region where the median is required should be made bold by clicking on it with the mouse (Figure 5-7b). If a median has never been calculated for a marker or region the notation “NA” will appear in the Statistics Table (Figure 5-8a). Once the “Calculate Median” option has been selected, the result will be displayed in the statistics pane of the Collect or Analyze tabs (Figure 5-8b).

![Figure 5-7](image1)

**Figure 5-7**  
a. Quadrant marker is not selected  
b. Quadrant Marker selected (bold lines)

<table>
<thead>
<tr>
<th>FL-A</th>
<th>Median CD3-FITC-A</th>
<th>Median FL2-A</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.4%</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>5.0%</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>2.0%</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>1.0%</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>0.0%</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FL-A</th>
<th>Median CD3-FITC-A</th>
<th>Median FL2-A</th>
</tr>
</thead>
<tbody>
<tr>
<td>4%</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>0%</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>0%</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>0%</td>
<td>550.0</td>
<td>153.0</td>
</tr>
<tr>
<td>1%</td>
<td>29490.0</td>
<td>2121.0</td>
</tr>
</tbody>
</table>

**Figure 5-8**  
a. Statistics table before selecting Calculate Median  
b. Statistics table after selecting Calculate Median

**Recalculate All Medians**: If a marker or region for which a Median value has been calculated is moved, the Median will not automatically recalculate. The notation “tbd” (to be determined) will appear in the Statistics Table (Figure 5-9). **Recalculate All Medians** should be selected to update the value (Figure 5-8b). The first statistics line will always read NA. There is no calculation of the All row.

![Figure 5-9](image2)

**Figure 5-9**  
a. Statistics table after moving Quadrant markers
The Instrument Menu

Set Threshold: Opens the Threshold dialogue box (Figure 5-11). This allows for selecting the trigger channel, setting the Primary Threshold value, and setting an optional Secondary Threshold. Changing the Primary Threshold to a parameter other than FSC-H will change the parameter that is being used to trigger the data collection. The threshold settings can be applied to either the sample currently being viewed or all the samples. Selecting All Samples will apply these settings to all of the previously collected data in the open CFlow workspace. This command is also available directly from the Control Panel via the Threshold button.

Take care when setting the Primary and Secondary Thresholds. When the thresholds are set before or during data collection, any events not meeting the threshold criteria will be not be acquired or saved. When changes are made to the threshold values after data collection, a warning message will appear if changing the threshold value will result in permanent loss of data not meeting the new threshold criteria from the data file (Figure 5-12).
**Set Compensation:** Opens the **Compensation Settings** dialogue box. The Compensation Settings dialog box can also be accessed from the instrument settings panel of the Collect tab, under the **Run** button.

Click on the parameter to be subtracted in order to enter a percentage subtraction value. In the example shown in Figure 5-13, the **FL2** button in the upper left corner has been clicked and the numbers in the percent box appear on a white background. A subtraction percentage value may now be entered. A grayed out box is not accessible until the parameter button to its left is clicked.

![Figure 5-13 Compensations Settings](image)

Compensation can be applied to the currently viewed sample or all samples simultaneously by choosing one of the options under the words **Apply to** in the lower left hand corner.

The Compensation dialog box can remain open and in view throughout data collection and analysis – there is no need to close it when moving between samples, making or changing plots and applying gates, or even when moving between the Collect, Analyze and Statistics tabs.

**Run Cleaning Fluid Cycle:** Runs a cleaning fluid cycle. This cycle takes ~16 minutes to complete and is different than the **Decontamination Fluid Cycle** that occurs during shut down.

**Run Decontamination Fluid Cycle:** Manually runs the **Decontamination Fluid Cycle** that is performed automatically during a normal shut down of the C6.

**Run Unclog Cycle:** Runs the Unclog cycle. This command is also directly available from the Control Panel via the **Unclog** button. Running the Unclog Cycle will cause fluid to drip out of the SIP. Be sure to remove your sample tube and place a blotted or empty sample tube under the SIP to catch the effluent.

**Run Backflush Cycle:** Runs the Backflush cycle. This command is also directly available from the Control Panel via the **Backflush** button. Running the Backflush Cycle will cause fluid to drip out of the SIP. Be sure to remove your sample tube and place a blotted or empty sample tube under the SIP to catch the effluent.

**Clean Flow Cell:** The flow cell will fill completely with cleaning solution aspirated from the sample tube on the SIP. This cycle will automatically shut down the C6 with cleaning reagent that will remain in the flow
cell, allowing the flow cell to “soak”. When the C6 is started up again after this cycle, a longer fluidics
Startup cycle will run and CFlow will indicate that an “improper shut down” has occurred. This longer cycle
will purge cleaning reagent from the flow cell and the C6 will be ready to use when Startup is complete.

**CAUTION:** Never run the Clean Flow Cell cycle without a tube containing at least 250 µL of fluid on the
SIP.

**Calibrate Fluidics:** Initiates the fluidics calibration feature of the C6, which will ensure that the instrument
provides accurate measurement of the volume aspirated from samples.

**Update Firmware:** Updates the C6 firmware. Use only when directed by Accuri Cytometers to upgrade
the C6 firmware with an official firmware release.

### The About Menu

![About Menu](image)

**About CFlow:** Opens a dialogue box containing the version of CFlow currently installed. It also has the
contact information for Accuri Technical Support.

**Technical Support Information:** Opens a dialogue box containing specific information regarding CFlow
and the C6. In the event of a problem with the C6, Accuri Cytometers Technical Support may ask for this
information.

**Get C6 Internal Log:** Disabled at this time.
Chapter 6 VirtualGain

VirtualGain is a feature in CFlow that allows the mimic of detector voltage adjustments. **It is strictly an analysis tool and should not be used while collecting data.**

There are certain instances where the position of a given peak in different samples should be the same or at a specific channel number regardless of the staining. Instruments that have voltage and amp gain controls allow the “movement” of peaks from sample to sample facilitating this. CFlow has VirtualGain instead of these controls. This tool allows you to mimic voltage and amp gain adjustments to reposition data on the axis after the data has been collected. VirtualGain is a gross adjustment, an approximate visual shift of the data.

In Figure 6-1 the negative peak in the Control and Sample 1 fall in similar channels (MFI = 28.2 and 29.7, respectively). However, the negative population in Sample 2 is further to the right (MFI = 73.4). In order to align the negative population peak of Sample 2 with the Control, use VirtualGain.

![Figure 6-1](image-url)
Applying VirtualGain

1. Open CFlow.
2. Select the Analyze tab.
3. Recreate the histogram or copy plots from Collect for application of VirtualGain (Figure 6-2).

VirtualGain can only be applied to one parameter at a time and must be done on a histogram plot. After VirtualGain is applied, the data can be viewed with or without the VirtualGain in any type of plot.

4. Apply the appropriate gating to the plots in Analyze. Gating is not automatically carried over in plots copied from the Collect tab.
5. Click on the histogram parameter label to reveal the Parameter List (Figure 6-3).

Figure 6-2 Recreate the histogram or copy plots from Collect

Figure 6-3 Click on the histogram parameter label to reveal the Parameter list.
6. Select **VirtualGain** from the Parameter List. The VirtualGain dialogue box will open (Figure 6-4).

7. Move the Peak Definition Marker (light blue vertical line) in the Standard Sample plot to the center of the peak that will be the reference point. Other sample(s) will be aligned to this position.

The plots in the VirtualGain dialogue box will be Zoomed to the same axes ranges as they are displayed in the Analyze tab. To Zoom in further or scale over a different range, use the Zoom Tools in the Analyze plot. There are no Zoom Tools in the VirtualGain dialogue box.

8. Click on the small Sample Grid in the center of the Sample to Align plot. A larger Sample Grid will appear.
9. Pick the sample to Align (to adjust the peak position in) by clicking its well (Figure 6-5). The grey well indicates the Standard Sample already chosen. Choose from blue wells for samples to Align to the Standard. Only a single sample can be chosen to align. To add additional samples see Step 14.

10. The chosen sample will now appear in the Sample to Align plot.

11. Move the Peak Definition Marker in the Sample to Align plot to the center of the peak that will be lined up to the Standard (Figure 6-6).
12. Click **Preview**. The display will now show the aligned sample with VirtualGain applied and the peak of interest will be aligned in both plots.

13. If the sample alignment is not in the desired position, reselect the Peak Definition Marker in the Sample to Align plot and reposition it. (Repeat Steps 11 and 12.)

14. To align other samples exactly as the first aligned sample, select “This sample and ….”. A sample grid will open to allow selection of additional samples. If the other samples need a different amount of VirtualGain, VirtualGain must be set individually for each one (Figure 6-7).

15. Click **Apply** to apply VirtualGain to the data. A black asterisk will now appear under the Sample to Align plot. This indicates that VirtualGain has been applied to that parameter for that sample. VirtualGain is only applied to the displayed data. It does not alter the FCS data. The VirtualGain is recorded only in the CFlow file (Figure 6-8).

16. Click **Close**.

---

**Figure 6-7** Step 14, To align other samples exactly as the first aligned sample.

**Figure 6-8** Step 15, A black asterisk appears under the Sample to Align plot.
17. The sample with VirtualGain applied will now have a black asterisk under the parameter label. The negative peak for Sample 2 now has a MFI = 26.7. Without VirtualGain, the MFI was 73.4 (Figure 5-9).

![Figure 6-9](image)

Figure 6-9 The sample with VirtualGain applied has a black asterisk under the parameter label.

18. To switch between the VirtualGain and native displays, click the asterisk. A black asterisk indicates VirtualGain applied, a grey asterisk indicates display of the original data (Figure 5-10).

![Figure 6-10](image)

Figure 6-10 Click the asterisk to switch between VirtualGain and native displays. A grey asterisk indicated native data, a black one Virtual Gain applied.

19. Overlays will automatically display VirtualGain, when applied. Sample 2 now lines up with the Control and Sample 1. The VirtualGain asterisk is not displayed in Overlays when VirtualGain is applied to some or all of the samples in the overlay (Figure 5-11).
20. To remove VirtualGain, select “Remove All VirtualGain” from the Display menu. This will remove VirtualGain from every parameter in every sample within the CFlow file.
Chapter 7 CFlow Sampler

Introduction
The CSampler™ is an optional accessory for the C6 flow cytometer that allows for the aspiration of samples prepared in 48- and 96-well plates and standard 12 x 75 mm tubes from a 24-tube rack. In order to operate the CSampler, CFlow Plus software must be upgraded to CFlow Sampler software. CFlow Sampler is based on the CFlow Plus platform, so much of the functionality is common to both platforms. This chapter outlines the additional capabilities of CFlow Sampler and differences from CFlow Plus.

Increased Data Capacity
CFlow Sampler has a higher total data capacity than CFlow Plus. When a 96-well plate is selected, the total event capacity has been increased to 96 million events. Each sample well is still limited to 1,000,000 events. The total event capacity has been similarly increased to 48 million events for a 48-well plate and 24 million events when utilizing the 24-tube rack.

Data Collection Tabs
CFlow Sampler has two tabs that can be used during data collection, Manual Collect and Auto Collect.

The Manual Collect tab is designed for running individual samples from a plate or tube rack. It can also be used to define the parameters which are going to be used to acquire data, prior to data collection, for either collection mode. The Manual Collect tab is also used to re-collect data from wells that have been previously run from the Auto Collect tab.

The Auto Collect tab is designed to automatically collect data from multiple samples in microplates or tube rack.

Auto-save
CFlow Sampler automatically saves sample data after it is acquired. Auto-save will occur at the completion of data acquisition in each well, whether using the Manual Collect tab or the Auto Collect tab. Auto-save will only save the most recent data collected. (If changes are made during analysis of previously collected data, such as changing the threshold value, these changes are not automatically saved. In addition, changes to analysis must be saved using the Save command from the File menu.)

Export Sample Settings
Accessible from the File menu, sample settings can be exported as a .csv file, allowing information to be opened in spreadsheet programs. Sample settings include acquisition criteria, sample names, parameter names, and compensation values.

CFlow Plus Compatibility
CFlow Sampler files are compatible with CFlow Plus software. CFlow Sampler files utilize the same .c6 extension. All data and plots will be recreated in CFlow Plus. While sample settings such as Wash and Agitate will not be accessible, they are not lost if files are opened in CFlow Plus and then reopened in CFlow Sampler.
Choosing a Plate Type

The first action that should be performed when setting up an experiment is to select a plate type, as shown in Figure 7-1. Every time a new CFlow Sampler workspace is opened, a plate type must be selected.

To assign a plate type, select the Plate Type Menu by clicking on the Plate Type Field. A drop-down menu will appear with the options, 96-well plate, 96-well (deep well) plate, 48-well plate and 24-tube rack (Figure 7-2).

The Accuri CSampler is compatible with 96-well plates (standard flat, u-, and v-bottom), 96-well deep well plates, 48-well plates and standard 12 x 75 mm tubes in a 24-tube rack.

Once a plate type is selected, the sample grid will display the available wells. For a 96-well plate, all 96 wells are available, for a 48-well plate, wells A1-F8 are available, and for the 24-tube rack, wells A1-D6 are available for data collection. Data can be collected into any well and in any order using the Manual Collect tab. When using the Auto Collect tab, data can be collected either horizontally or vertically through the available wells, starting at well A1.

Naming a Plate

In addition to naming individual samples/wells within the plate, the entire plate can also be named for
future reference. Simply, type a label in the **Plate Naming Field** (Figure 7-1).

**The Manual Collect Tab**

The Manual Collect tab has a similar layout to the Collect tab in CFlow Plus (Figure 7-3) and is used in the same manner. Simply select a well, as indicated by the red outline, input the desired acquisition parameters, and click **RUN**. See Chapter 3 for more details.

![Manual Collect Tab](image)

There are several unique features in the Manual Collect tab: the ability to load and eject a plate, the option to wash the SIP between samples, and the ability to agitate, or mix, samples.

**Load/Eject**

Selecting the **Load/Eject** function will move the CSampler arm and plate platform in or out of the C6 to facilitate the placement of a plate or tube rack on the plate platform or remove a plate after sample acquisition is complete (Figure 7-4). After 15 minutes in the eject position, the arm and plate platform will automatically return to the home position with the SIP in the wash station.

**Wash**

Clicking the **Wash** button will activate a single wash cycle, thoroughly cleaning the SIP of any previous
sample. The contents of the SIP are aspirated up and out of the SIP, then the SIP and wash station are rinsed with clean sheath fluid. Selecting Wash from the Manual Collect tab will perform a single wash cycle. Using Wash from the Auto Collect Tab allows for multiple washes to be performed automatically after each well is complete. Up to 5 wash cycles can be selected. Experience has shown that running one wash cycle will typically reduce carry-over to <1.0%. Running two wash cycles will typically reduce carry-over to <0.1%.

**Agitate**

Clicking the **Agitate** button will activate a single agitation cycle. Agitate is designed to keep a sample in suspension. It is not designed to re-suspend a completely settled sample. Selecting Agitate from the Manual Collect tab will perform a single agitation cycle. Using Agitate from the Auto Collect tab allows for multiple cycles (up to 5) to be performed automatically at given time intervals during the plate run. Agitation is only performed when the SIP is clear of any well or tube.

**Fluidics Commands**

Since the SIP is not easily accessible with the CSampler installed, some of the fluidics commands have been modified.

**Backflush**

When the **Backflush** command is selected, the CSampler will automatically move the arm and plate platform to the Eject position, allowing a container to be placed under the SIP. After placing a container under the SIP to catch any fluids that will be ejected from the SIP, click the **Backflush** button in the Run Backflush Cycle window (Figure 7-4).

![Figure 7-4 The Run Backflush Cycle window.](image)

**Unclog**

When the **Unclog** command is selected, the CSampler will automatically move the arm and plate platform to Eject position. After placing a container under the SIP to catch any fluids that will be ejected from the SIP, click the **Unclog** button in the Run Unclog Cycle window (Figure 7-5).

![Figure 7-5 The Run Unclog Cycle window.](image)

**Calibrate Fluidics**

The fluidics of the C6 can be calibrated for the volumes typically run from a 96-well plate. This operation requires that at least 150 L is placed within the well. Once a plate is prepared with the appropriate volume, load it onto the CSampler. Upon selecting Calibrate Fluidics, a window will indicate which well the C6 is going to use for the fluidics calibration (Figure 7-6). This well will also be indicated by a red box in the Sample Grid. If this is not the desired well, switch to the Manual Collect tab and select the proper
well. After the proper well is indicated, click Calibrate. The calibration will take several minutes. Refer to the Accuri C6 Instrument Manual for detailed information.

![Calibrate Fluidics Window](image)

**Figure 7-6 The Calibrate Fluidics window.**

**Using the Manual Collect Tab**

The Manual Collect tab is designed for three purposes:

1. To run samples individually from any plate type or tube rack. When using this tab, settings such as Run Limits, Thresholds, and Color Compensation can be applied to either the current sample being viewed, indicated by a red box surrounding the well, or to all the samples in the sample grid.
2. To assist in setting up experiments that will be processed using the Auto Collect Tab. The following can be done using the Manual Collect Tab, prior to swapping to the Auto Collect Tab:
   a. Plot creation
   b. Gating schemes
   c. Setting threshold values, primary threshold channel (trigger), secondary threshold channel
   d. Color compensation
   e. Run Limit settings applied to individual wells from the Manual Collect tab are not carried over into the Auto Collect tab.
3. The Manual Collect tab can also be used to collect data from a plate if the plate has been interrupted or aborted in the Auto Collect Tab.

All of the plot tools available in CFlow Plus are available in the Manual Collect tab. Creating plots, regions, gating schemes, and other analysis features are described in Chapter 3.
The Auto Collect Tab

The Auto Collect tab (Figure 7-7) is designed to facilitate the automatic running of multiple samples from a well plate or the sample tube rack.

There are two fundamental differences between the Manual Collect tab and the Auto Collect tab. The first is that the Auto Collect tab does not allow the creation of plots. This has been replaced with the ability to easily label a large number of samples. The second difference is the ability to create “sets” of samples.

Sample Annotation Table

The right side of the Auto Collect tab contains the Sample Annotation Table. This table allows for the naming of samples, renaming of parameters, and adding a specific notation to each sample. Information can be entered manually for each individual sample or directly imported from a spreadsheet program using the Copy (Ctrl+C) and Paste (Ctrl+V) commands. The table layout is fixed and therefore sample names must be entered across rows (1-12) before moving down the columns (A-H) of the sample grid.

Individual fields can be selected by clicking in them with the mouse or advancing with the Tab key. The keyboard arrow keys do not function in this view.

Text in a field can be select by double clicking in the field.

When the Open Run Display button is selected, the Sample Annotation Table is replaced with a new...
window containing a single plot. This plot is described in the Run Display section.

Creating Sample Sets and Applying Acquisition Settings

Selecting Samples
A sample well can be selected by clicking on it with the mouse. Unlike the Manual Collect tab where selected wells are indicated by a red box, selected wells in the Auto Collect tab will contain a black checkmark (tick) as seen in Figure 7-8.

Creating a “Set” of Wells (Samples)
A set is a grouping of samples that will be acquired using the same acquisition criteria (number of events, threshold setting, etc). Sets can be created in several ways:

1. Individually select the wells.
2. Click on the Column (1-12) or Row Header Labels (A-H). This will select the entire column or row. Multiple rows and columns can be selected simultaneously.
3. Selecting all the sample wells in the Sample Grid. Above the Sample Grid are “Select All” and “Deselect All” commands (in blue text). Clicking “Select All” will select all the wells.

Samples can be unselected by using the same methods.

An entire set can be selected by double-clicking on any of the sample wells within that set.

Once single or multiple wells have been selected, settings can be applied. This is indicated by the **Apply Settings** button becoming active (Figure 7-8).

![Figure 7-8 Selecting an individual sample.](image)

Apply Settings
After a sample or set of samples has been selected, input the criteria by which these samples are to be collected. This includes Run Limits, Fluidic settings (Slow, Med, Fast), and the desired threshold(s). The option for custom fluidic settings (Flow Rate and Core Size) has been disabled in the Auto Collect tab. Wash cycles (0-5) can be chosen to occur after each sample well is complete. Apply settings by clicking the **Apply Settings** button. Selected samples will be highlighted the same color once settings have been applied to the set, or group of samples (Figure 7-9).
If Run Limit or Flow Rate and Core Size settings are modified using the Manual Collect tab, those settings will not change in the Auto Collect tab. Threshold settings and Color Compensation settings will apply to both tabs.

![Figure 7-9](image)

Applying settings to a set of samples will turn those sample wells the same color.

Each new set of samples or sample settings will be displayed with a different color (Figure 7-10). There are 12 colors available; however, up to 96 sets can be created. The colors will be reused in the same order starting with the 13th set created.

![Figure 7-10](image)

The Auto Collect tab displaying two sets.

The first time **Apply Settings** is selected, CSampler will prompt a Save File dialogue box. This will designate the name and location of the file that will contain the data about to be run in this session of
CSampler. This is where Autosaved data will be saved.

Once the file has been saved, the OPEN RUN DISPLAY button will become active.

Every time Apply Settings is clicked while defining the acquisition parameters for the plate, the settings are resaved. Once the Auto Collect Run has been started, the data will be automatically saved after each sample is complete and before the next well begins to acquire data.

Modifying Settings

After a set is created, its settings can be modifying by reselecting the well that are to be changed. After changes are made and settings applied, selected wells will change to a new color.

View Sample Settings

After settings have been applied to a workspace, the settings of a particular well can be viewed by Ctrl+Click on the well of interest. The red box will move to the well that has been selected this way.

Remove Settings

After settings have been applied to a set, they can be removed using the Remove Settings button. Settings can be removed from one or all of the samples within the set by either reselecting the entire set (double-clicking one of the samples within the set) or selecting the samples individually by clicking on them. When settings are removed from a sample, the sample well will revert to a white box. The acquisition settings displayed in the Control Panel will not change.

Agitate

While running from Auto Collect, CSampler can automatically perform plate agitation at periodic intervals. Agitation can be set to occur in 1 minute intervals, up to 30 minutes, throughout the duration of the plate run. Agitate will not interrupt data collection. If the interval is reached during acquire, the well will finish and then the agitation will occur. As stated previously Agitate can be selected to perform between 0 and 10 agitate cycles.

Agitate settings are applied to the entire plate or tube rack and can not be applied to individual wells.

Run Direction

Data can be collected from plates in either the horizontal (A1, A2, A3, etc.) direction or the vertical (A1, B1, C1, etc.) direction. This is determined by choosing the Run Horizontally or Run Vertically toggle beneath the Settings Controls in the Control Panel.
The Run Display

The Run Display is used during data collection in the Auto Collect tab. To access the Run Display window, click the **OPEN RUN DISPLAY** button. This button is only active after one or more wells have had settings applied. Once the Run Display is opened the Sample Notation Table will be replaced with the Run Display. The Run Display contains a single larger plot (the Sample View Plot), an additional traffic light status indicator, the data acquisition counters, and several Pause alternatives (Figure 7-11).

The Control Panel is disabled while the Run Display is open. In order to return access to the Control Panel, the Run Display must be closed using the **CLOSE RUN DISPLAY** button.

![Figure 7-11 The Run Display](image)

Sample View Plot

All plots created in the Manual Collect tab are listed in the Select Plot drop-down menu beneath the plot window and can be selected at any time during data collection. One plot at a time can be viewed. Plots can only be modified, deleted or added from the Manual Collect tab.

Alternative Pause Commands

In place of the traditional **PAUSE** button found in CFlow Plus, CFlow Sampler contains an **INTERRUPT PLATE** button and an **ABORT WELL** button. These buttons will only be active when CFlow Sampler is acquiring data.

**INTERRUPT PLATE** will complete data collection from the current well and perform specified wash and agitate cycles before stopping the plate run. At this point, the plate can be ejected. When a plate is interrupted, the Auto Collect tab is disabled, except to restart, and the settings cannot be changed. In order to collect data during an Interrupt state, the Manual Collect tab must be used. This ensures that the run settings of the interrupted plate are retained when the plate run is restarted. The plate run can be
restarted by selecting the AutoRun button. Upon restart of the plate, CFlow Sampler will begin at the next sample well.

**ABORT WELL** will immediately stop data acquisition, stop the fluidics, and eject the plate. This is similar to **PAUSE** in CFlowPlus. Upon restart of the Run, CFlowSampler will begin at the next well. It will not continue to collect from the aborted well. Similar to **INTERRUPT PLATE**, the Auto Collect tab is disabled after an aborted well. Settings cannot be changed from the Auto Collect tab in the aborted state.

**Acquiring Data**

To begin data acquisition, click the **AUTORUN** button.

Within Auto Collect, CSampler will always start collecting from position A1. If A1 is not selected as part of a set, CSampler will advance either horizontally or vertically to the first well that has settings applied to it and begin acquiring data.

As data is acquired and the CSampler advances through the plate or tube rack, completed samples will display a small blue square in the upper left corner of the well. The red box indicates which sample the CSampler is currently acquiring data from. The current well will also flash blue during data acquisition, similar to CFlow Plus.

When the plate or all of the sets of samples have finished, **DONE!** will be prominently displayed across the Run Display window (Figure 7-13).
Once a plate is complete, the Run Display must be closed in order to continue using CFlow Sampler. The Run Display is closed by clicking the **CLOSE RUN DISPLAY** button. This will return the Sample Annotation Table to the screen. Analysis can then be completed using the Analysis and Statistics tabs.

**Analyze and Statistics Tabs**

The Analyze and Statistics tabs are used in the same manner as CFlow Plus. Please see Chapter 3 for a complete description of these tabs.
Running a Sample Plate (Example)

The following is intended to provide an example of a typical setup and data collection workflow using CFlowSampler software.

1. Open CFlow Sampler software.
2. Select the Manual Collect tab.
3. Select a plate type from the Plate Type Menu.
4. Create the plots that are going to be needed for running the plate or load the template.
5. If necessary, acquire some events to define regions, gating, etc.
6. Switch to the Auto Collect tab.
7. Select the wells in the Sample Grid where data will be collected.
8. Set the desired acquisition settings, such as number of events, threshold, washes needed, etc.
9. Apply Settings.
10. Define the file name for Autosave.
11. Enter sample names and labels into the Sample Annotation Table manually or import them from a spreadsheet program.
12. Select agitation schedule.
13. Select the direction the plate is to be Run.
14. Open the Run Display
15. Select the Plot to view during acquisition from the Plot dropdown
16. Click AutoRun.
17. When the plate is complete, close the Run Display.
18. Switch to either the Manual Collect or Analyze tabs to review and/or analyze the data.
Collisions and Alignment

If instructed to do so by the software, an alignment should be performed by selecting **Align** from the popup (Fig. 7-14). Alignment can also be performed at any time by selecting **Align** from the **Instrument** Menu.

If there is an obstruction in the path of the CSampler arm, CFlowSampler will indicate that a collision has occurred. The message box shown in Figure 7-14 will be displayed, together with a red Traffic Light. In order to continue using the CSampler, an alignment must be performed. Before running an alignment any objects previously placed on the CSampler mat should be removed.

![Collision Detected](image)

*Figure 7-14  Collision detected window*

If a second collision occurs a second alignment will begin automatically. If the secondary alignment fails, please contact Accuri Technical Support.